


دیر آمدیم اما پر بار تر از آنچه فکر می کردیم.  بالاخره با 
تلاش گروه هنری فتوگراف ، شاهد نخستین شماره رسمی 
مجله فتوگراف هستیم . با تلاش و امید بود که توانستیم 

سد موانع را بشکنیم و تا هنر را کشف کنیم. 
قابل توجه شما دوستان و همراهان عزیز!  وب سایت مجله 
نیز با سیمایی جدید رونمایی شد و شما می توانید بخش 
های هر شماره را در وب سایت ببینید و به اشتراک بگذارید 
و همچنین آخرین اخبار مجله و دنیای هنر را دنبال کنید. 
جا دارد در این آغاز، از حامیان رسانه ای مجله تشکر کنیم.

حامیان رسانه ای ما :

 پرشين جی اف ايكس ، پی سی دانلود، 
پرشين گرافيك، فتوليا ،اينفوگرافيك، 

رسم ،ايران وب نيوز 
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صفر بگیرید!!

شماره صفر مجله فتوگراف را دانلود کنید



چشمِ اميدمان به آسمانِ چشمِ هنرمندان است

از روزي که نهال عکاسي در خاک این سرزمین کاشته شد سالها مي گذرد. ایران، استادانِ زبردستي در هنرِ وزینِ عکاسي به خود دیده، که در 
شاخه هاي مختلف عکاسي سر آمد بوده اند. رشد روز افزون عکاسي، که همانا هموار شدن راهي است که به رساندن پیامي براي دیدن، فهمیدن 
و زندگي کردن منتهي مي شود، وجد و شعف جهانیان را بر انگیخته و مردم عامه هم لا اقل به دوربین هایي دل بسته اند که نگاهي، لبخندي 

و خاطره اي را برایشان ثبت مي کند.
اما در مقابل آن، گرافیك ایران هنوز نوجواني است که به راستي و درستي شناخته نشده است و متاسفانه هنوز خیلي از مردم از کاربرد و تأثیر بي 
نظیر آن بي خبرند. هنوز پي نبرده اند به لذت نگاه به اثري که دل در راه آن نهاده شده، هنوز نشناخته اند استاداني را که عمر داده اند به پاي 

هنري که همچون عکاسي، نقاشي و هنر هاي تجسمي دیگر از روح و دل بر مي آید.
با تمام پرواز ها و گاه هم سقوط ها، به امروز رسیده ایم. حال در فضاي سنگین و آلوده ي این روزها، رمقي اگر مانده تنها با تلاش هنرمنداني 

بوده که به خورشید مي اندیشیده اند و آرام آرام در حال باز کردن روزنه اي به امید هستند. چشم امیدمان به آسمان چشم هنرمندان است.
مي خواهیم فتوگراف راهي باشد براي هموار کردن این مسیر. مي خواهیم و مي توانیم که هنر را به دلِ شیفتگان آن راه دهیم . در تابستاني که 
پیش روست نمایشگاه هاي متعدد عکاسي، پوستر،نقاشي و ... متعددي در شرف برگزاریست، همچنین مسابقات مختلف و فراخوان هاي فراواني 
در رسانه ها تبلیغ مي شوند که نشان از بهار سبز هنر دارد. در این تکاپو، فتوگراف به بومي شدن هنر مي اندیشد، به خصوص هنر گرافیك. دست 

هاي یاري مي تواند انرژي و توان ما را در مسیر این اهداف صد چندان کند.
بعد از اینکه شماره صفر مجله تخصصي عکاسي و گرافیك فتوگراف، در آخرین روز هاي سال 1390 منتشر شد، سایت مجله نیز افتتاح شد تا 

علاقمندان به راحتي به همه شماره هاي مجله دسترسي داشته باشند و بتوانند نگاهي به آنچه در فتوگراف اتفاق مي افتد نگاهي داشته باشند.
در اولین شماره رسمي فتوگراف مي خواهیم دست در دست هم، روزنه هاي کوچك نور را به خورشیدي از رنگ و نور بدل کنیم. باید از این پس 
تلاشمان بر خلاقیت باشد، باید خوب نگاه کنیم، بشناسیم و بفهمیم. این شروع کار براي عکاسي و گرافیك است. مي توان با نگاه نو چنگ بر 

پرده هاي سیاه زد. مي توان با شناخت هنر به آزادي رسید.

سخن نخست
1391 

ر ماه 
تی



اختصاصي فتوگراف- نخستین جشنواره اینفوگرافیك فارسی - داده های رنگی- برگزار مي شود.

به گزارش فتوگراف به نقل از روابط عمومي جشنواره، نخستین جشنواره اینفوگرافیك فارسی - داده 
های رنگی- با هدف ترغیب افراد به استفاده از شیوه های نوین ارائه مطلب ، گسترش و بومی 
کردن این هنر و همچنین ارتقای سطح کیفی آثار طراحان کشور عزیزمان ، ایران ، در تابستان سال 

1391 برگزار مي گردد.
 ،)  IT,ICT( این جشنواره در بخش های آماتور و حرفه ای موضوعات آموزش، آی تی و آی سی تی
اجتماعی، اقتصاد و تولید ملی، پزشکی و سلامت، تبلیغات اسلامی)دینی و مذهبی(، رسانه، سیاست، 
صنعت، فرهنگی، گردشگری، محیط زیست، مدیریت،معماری و شهرسازی، ورزش را در برمي گیرد.

مجله مجازی گرافیك و عکاسی فتوگراف به عنوان حامی رسانه ای این جشنواره آرزوی موفقیت 
برای این جشنواره دارد.

وب سایت جشنواره 

http://www.infographicfestival.com


بستنی و مغز گردو فیلی
در این آموزش قرار است با استفاده از تکنیك دستکاری عکس در فتوشاپ ، 

یك ترکیب جالب و نوینی پدید آوریم

 Adobe Photoshop CS5 نام برنامه: نرم افزار
سطح آموزش : متوسط

برآورد زمان اتمام: 2 ساعت
تعداد گام ها  : 18 تا

تعداد تصاویر آموزشی : 40 تصویر
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 Ctrl + V و Ctrl + C ابتدا تصویر لیوان را باز کنید  و مطابق تصویر قسمتی از لیوان را انتخاب و با فشار دادن کلید های
قسمت بالایی لیوان را در لایه جدید بوجود بیاورید. )تصویر شماره 1(

لایه جدید را انتخاب کنید و کلید های Ctrl + T را فشار دهید، روی صفحه کلیك راست کرده و گزینه Warp را بزنید  
)تصویر شماره 2( و قسمت پایینی تصویر را به سمت پایین بکشید.

به عنوان یك گام اضافی ، به منوی Filter  و بعد آیتم Liquify )با کلید های میانبر Shift+Ctrl+X ( را 
انتخاب میکنیم و مطابق تصویر قسمت پایینی گردی لیوان را به پایین بکشید . این کار با چشم انداز طرحمان 

کمك می کند.)تصویر شماره 3(

تصویر 2

تصویر 3

گام 1

تصویر 1

گام2
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مطابق گام اول  قسمت پایه لیوان را انتخاب و با فشار دادن کلید های Ctrl + C و Ctrl + V قسمت پایه لیوان را در لایه 
جدید بوجود بیاورید. )تصویر شماره 4(

لایه فوق )پایه لیوان( را با استفاده از کلید های Ctrl + T فرماندهی کرده و به صورت عمودی بکشید )تصویر شماره 5(

با پایین نگه داشتن کلید Alt با ابزار Brush Tool نمونه رنگ 
پس زمینه را انتخاب کنید و یك پس زمینه یکنواخت به تصویرتان 

بدهید )تصویر شماره 6(

قسمت پایه لیوان را در یك لایه جدید اضافه کرده و بصورت 
معکوس دربیاورید )تصویر شماره 7( ، تمام لایه ها را به کلید 
های Ctrl +Shift+E  به لایه Background  تبدیل 
کنید و به پایین صفحه انتقال دهید همانند )تصویر شماره 8( .

تصویر 5

تصویر 7  تصویر 8 

تصویر 6

گام 3

تصویر 4

گام4
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بعد، انتخاب فضای بالای لیوان را انتخاب و آن را به بالای تصویر بکشید. )تصویر شماره 10(

گام بعدی این است که با استفاده از ابزار Pen Tool طریق 
تصاویر خود را از فیل و استخراج کنید. )تصویر شماره 11(

هنگامی که استخراج تمام قطعات شما انجام شد ، آنها را به 
لایه جدید وارد کنید. )تصویر شماره 12(

تصویر 10

تصویر 11  تصویر 12 

گام 3

گام4
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 Clone Stamp حالا نوبت به آن است تا تصویر رو کمی مرتب و تمیز کنیم با استفاده از
Tool  شما میتوانید ترفندی برای حذف عاج فیل استفاده کنید)تصویر شماره 13(

من هم بخش هایی از بدن که آسیب دیده شده اسا را کپی و بازسازی میکنم همانند تصویر 
شماره 14

تکه ای از گوش که روی بدن قرار دارد و همچنین به بازسازی پاها و حذف زنجیر ها میپردازیم )تصویر شماره 15 و 16(

تصویر 13 

تصویر 15  تصویر 16 

تصویر14

گام 5

گام 6
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در این مرحله باید تمامی اجزای فیل باید با تکه بزرگ فیل رنگبندی یکنواخت داشته باشد  ابتدا تکه بزرگ فیل را در 
Match Color باز میکنیم و مقادیر را همانند تصویر تنظیم میکنیم. )تصویر شماره 17(

 Image > Adjustments > Match Color

این کار را برای پاها و دیگر قطعت انجام میدهیم

بافت بر روی پاها و بدن به نظر می رسد بیش از حد صاف است ، ما برخی از نمونه بافت را از لایه بدن و پاها را انتخاب 
کرده و به بخشی از بدن که دارای بافت خوبی نیست اضافه میکنیم .)تصویر شماره 18(

بافت ها را کپی و روی قطعات بچسبانید و با استفاده از Transform بافت ها را مطابق با بافت های قطعات تنظیم کنید. 
)تصویر شماره19 و 20(

با استفاده از یك لایه ماسك و Blending Mode رنگی تیره به بافت جدید میدهیم تا هم سطح قطعه مورد نظر باشد.
) تصویر شماره 21(

تصویر17 

تصویر18  تصویر19  تصویر 20 تصویر 21 

گام7

گام8
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در این مرحله ما میخواهیم قطعات را جداگانه ویرایش و وارد لیوان کنیم ، ابتدا قطعه بزرگ بدن را در یك لایه جدید کپی 
کنید و با رفتن به منوی Edit  و انتخاب Transform  قطعه را درون لیوان جای گذاری میکنیم . )تصویر شماره 22(

با استفاده از ابزار Pen Tool را برای فضای داخل لیوان شیشه ای را انتخاب کنید و بعد وارد قسمت پنل ماسك شوید 
و گزینه Add Vector Mask را بزنید . ) تصویر شماره 23(  

یك لایه دیگر بدن همراه با گوش را مانند مرحله قبل انجام می دهیم ، و همچنین یك لایه دیگر بدن را تا تصویری مشابه تصویر فوق 
داشته باشیم. )تصویر شماره 24 و 25(

منوی   به  ماسك  پنل  به  ورود  برای   : نکته 
windows وبعد گزینه Mask را بزنید 

تصویر22 

تصویر25 تصویر23 

تصویر24 

گام9

گام10
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همانند  ماسك  و   Pen Tool تکنیك  از  استفاده  با 
شکل ، برآمده گی با یکی دیگر از اعضا به لیوان اضافه 

میکنیم . )تصویر شماره 26(

بعد یك کپی از لایه “سر” بگیرید و درون لیوان جای 
دهید . )تصویر شماره 27(

ران  قبلی  و طبق دستور های  در یك لایه جدید 
و کف پای فیل را به تصویر و درون لیوان اضافه 

میکنیم. 
)تصویر شماره 28 و 29(

تصویر26

تصویر27 

تصویر28 تصویر 29

گام11

گام12
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برای اینکه تصویر ما با جلوه ای بهتر درون لیوان نمایش داده بشود باید قسمت هایی 
کنیم  سایه  کشیدن  به  شروع  بدن  روی  تیره  خاکستری  رنگ  نمونه  با  را  تصویر  از 

)تصویر شماره 30(

ادامه این روش با هر قطعه ای از فیل.)تصویر شماره 31(

هدف بعدی این است باید کاری کنیم که نشان دهیم فیل 
درون لیوان و پشت شیشه است بنابراین در یك لایه جدید 
با استفاده از یك قلم مو و رنگ سفید بیش از فیلپ در آن 

که نشان دهد فیل در تماس با شیشه است. 
)تصویر شماره 32(

تصویر30

تصوی32

تصویر31

گام13

گام14

مجله فتوگراف / شماره یک / سال اول / تیر ماه 1391 / رایگان
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به  و  برسانید  به 27 درصد  را  این لایه   Opacity یا  شفافیت 
تنظیم  را  زیر  مقادیر  و  بروید   Blending Options منوی 

کنید. )تصاویر شماره 33 و 34(

این کار را برای اجزای دیگر هم انجام میدهیم تا شکل طبیعی به 
تصویرمان بدهد )تصویر شماره 35(

در این مرحله یك لایه جدید اضافه میکنیم و با قلم موی نرم 
و بزرگ در برخی از لبه های فیل را با رنگ سفید می پوشانیم 
تا  میدهیم  قرار  درصد   27 بروی  را  تصویر  شفافیت  میزان  و 

منعکس کننده نور باشد. )تصویر شماره 36(

این کار را بروی لبه لیوان هم انجام میدهیم و شفافیت را بروی 
33 درصد قرار میدهیم )تصویر شماره 37(

تصویر33

تصویر34

تصویر36 تصویر 37

تصویر35

گام15

گام16

مجله فتوگراف / شماره یک / سال اول / تیر ماه 1391 / رایگان
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تصویر دسر و باز کرده و با ابزار Pen Tool قسمت خامه ای 
عکس را انتخاب میکنیم )تصویر شماره 38(

و با استفاده از کلیدهای Ctrl +T  تصویر را برعکس میکنیم 
روی قسمت برآمده لیوان قرار میدهیم. )تصاویر شماره 39(

در نهایت باید به کرم بستنی مقداری سایه اضافه کنیم تا تصویر بهتری از کرم روی 
فیل داشته باشیم )تصویر شماره 40(

آموزش ما به اتمام رسید و شما باید تصویر مانند تصویر زیر داشته باشید

تصویر39

تصویر40

تصویر 38

گام18گام17
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آموزش و تصاویر طراحی شده خودتان را برای ما ارسال کنيد
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افتخارم این است که بار این 
فرهنگ و هنر را به دوش مي کشم

گفت وگوی اختصاصی با استاد علیرضا صدیقی

     براي عليرضا صديقي، استاد گرافيك مقيم هلند، آغاز گرافيك به 
باز ميگردد، درست زماني كه وارد هنرستان هنرهاي  29 سال پيش 

تجسمي شد .
 اين هنرمند كه متولد سال 1346 در تهران است، پس از فارغ التحصيلي 
در رشته گرافيك از هنرستان هنر تهران در همان سال وارد دانشگاه 
هنر در رشته نقاشی شد . سال 1372 بود كه به هلند مهاجرت كرد 
و پس از آن يك دوره ي 2 ساله آموزشی كامپيوتر و 2 سال هم دوره 

معلمی در رشته هنر در دانشگاه هنر فونتيس گذراند.
اصفهان كه پيش از اين نيز ميزبان آثار او بوده است،26 فروردين تا 23 
ارديبهشت ماه 1391، در موزه هنر هاي معاصر 43  پوسترِ اين طراح 

گرافيك ايراني را به نمايش مي گذارد.
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در زير گفت و گوي فتوگراف را با اين هنرمند مي خوانيد:

  . شروع گرافيك براي عليرضا صديقي از چه زماني بود؟

گرافیک را وقتی 16 سالم بود شروع کردم. سالی که بعد از امتحان ورودی هنرستان 

این هنرستان  بود که  اولین سالی  این هنرستان شدم،  هنرهای تجسمی وارد 

هنرجو می گرفت. گروه کوچکی بودیم. آن زمان شادروان اصغر محمدی رییس 

هنرستان بودند و اساتید صاحب نامی همچون استاد نامی، استاد معتبر، استاد 

شریف آبادی در آنجا حضور داشتند.

 .  از با ارزش ترين افتخارات بين المللی كه كسب كرده ايد، بگوييد ؟

راستش را بگویم، من زیاد به دنبال این چیزها نیستم و در این مراسم ها زیاد 

شرکت نمی کنم. بزرگترین افتخارِ من این است که یک ایرانی هستم و بار این 

فرهنگ و هنر غنی را بر دوش میکشم.

  .  نمايشگاه پوستر در اصفهان چگونه است؟
بار دیگر توانستم در  افتخارات من است، چون  از  نمایشگاه یکی  این  داشتن 

وطنم ایران کارهایم را به نمایش بگذارم و با کارهایم نشان دهم که؛ یک ایرانی هر 

چند که در ایران نباشد، اگر بخواهد میتواند یک ایرانی بماند و خودش را در این 

فضاها گم نکند و همیشه این را در خاطرش داشته باشد: »که هست و از کجا 

آمده « و به آن افتخار کند. به این افتخار کنیم که همیشه فرهنگ و هنر ما بر 

عکس سیاستهای ما سرآمد دنیا بوده و هست و دنیا خود نیز به این امر آگاه 

است. جالب اینجاست که خودم هیچ وقت این فیض را نداشتم که به اصفهان 

بروم، اما خوشحالم که دو نمایشگاه در آنجا داشته ام، در خانه گرافیک و حالا 

هم در موزه هنرهای معاصر. 

از همه دوستان و عزیزانی که به من محبت کردند و در برگزاری این نمایشگاه 

زحمت کشیدند، تشکر فراوان میکنم.
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مربوط به خود را دارد. اما در خارج از ایران به این خاطر که 

تازگي خاصي براي افراد دارد، با استقبال بهتری مواجه 

می شود. آنجا بیشتر با هنر مینیاتور و قالیبافی ایران 

آشنا هستند . هنر گرافیک ایران هم به خصوص وقتی 

تایپوگرافی در کارهاي گرافیکي باشد، حتي اگر نتوانند 

آن را بخوانند، برایشان تازه و جذاب است. البته گاهی 

اوقات برای خود من هم قابل خواندن نیستند.

.  معناي گرافيك از نظر شما چيست ؟ 
در حال حاضر گرافیک معانی مختلفی به خود گرفته 

که  گوید  می  یکی  تایبوگرافی شده،  یکی  برای  است. 

هنر  دارد  کار  و  سر  دهنده  سفارش  با  چون  گرافیک 

نیست ، دیگري می گوید که یک هنر غربی است و با 

هنر و فرهنگ ما هماهنگی ندارد و تعاریف فراوان دیگر.

به نظر من جدا از این که اصل گرافیک کجا و چطور به 

کاملا  مورد  دو  کتاب  جلد  با  پوستر  طراحی 

که  است  محصولی  کتاب  هستند.  متفاوت 

بیننده در دست خود می گیرد و زمان کافی 

دارد که به طور کامل، آن را ببیند و بخواند، که 

این موارد در مورد پوستر صدق نمی کند. در 

پوستر باید صریح و خوانا بود و بیننده زمان 

زیادي ندارد تا با طرح کلنجار برود و چیزي از 

آن بفهمد. جلد کتاب ملزم نیست تا متن کتاب 

را بازگو کند و فقط جذابیت آن میتواند کافی 

باشد تا بیننده را به طرف خود جذب کند. که 

باز این در مورد پوستر صدق نمی کند و همین 

طور چندین مسایل دیگر.

 .  رنگ مورد علاقه شما چيست ؟

من رنگ خاصی را ندارم. به رنگ های خام، زیاد 

 .  برگزاری نمايشگاه خارج از ايران موفق تر است يا داخل ايران؟
 .   با توجه به تجربه شما در زمينه هنري تان، در طراحی پوستر و جلد كتاب، 

چه نکاتی هست كه بايد بيشتر به آنها توجه كرد؟

علاقه اي ندارم و بیشتر رنگ های ترکیبی را استفاده میکنم . به نظرم 

رنگ یک عنصر خیلی مهم در کار است و به وسیله آن مي توان خیلي 

حرف ها گفت.

وجود آمده، گرافیک یعنی تبدیل و تعبیر یک موضوع یا یک عنوان به فرم 

بصری و تصویری است که برای عموم مردم و مخاطبان آن قابل فهم باشد. مثال 

خیلی ساده آن هم علایم راهنمایی و رانندگی است. صحبت از این موضوع، 

زمان و گفتگو زیادي را مي طلبد.
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 .  واضح ترين تفاوت بين ما ايرانی ها و هلندی ها در گرافيك چيست ؟ 

نظم ، اگاهی ، اطلاعات ، تحقیق و امکانات.

 .  آيا پوستری هست كه بعد از طراحي آن، خودتان تحت تاثير ايده  ويا طراحيتان 

قرار گرفته باشيد؟ كدام اثر خودتان را بيشتر دوست داريد ؟

یاد  به  مرا  آنها  از  رابطه ای خاص دارم، چون هر کدام  با کارهایم یک  من 

دورانی از زندگی ام می اندازند. همیشه سعی میکنم در آنها اشتباهاتم را 

ببینم و در کارهای بعدی ام اصلاحشان کنم. اما در این میان پوستری هست 

که حس خوبی به من  می دهد و آن پوستر تبریک سال نو 2010 میلادی 

است. این پوستر در عین سادگی حرف هایی را در خود دارد که هر بیننده 

به نحوي برداشت خاصي از آن مي کند. و  از این جهت برای من جالب است
که؛ روزی یکی از دوستان در ایران می گفت که مردم در ایران این پوستر من را به 

عنوان تصویر روی تلفن همراه خود استفاده می کنند و این یک حس خوبی به من 

داد.  از همه هموطنان خوب و مهربانم  سپاسگزارم

 .   در آخر حرفی اگر باقی مانده بيان كنيد ؟

عرض دیگری نیست از شما و دیگر همکاران شما تشکر میکنم و سلامتی و پیشرفت 

روزافزون ایران و ایرانی را از خداوند بزرگ خواستارم.
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معرفی انيميشن

 و    بررسینقد
انيـــميشن

Dr. Seuss The Lorax

مرجع : سایت نقد فارسی
مترجم : بهروز آقاخانیان
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معرفی انيميشن

ژانر : انیمیشن، خانوادگی، فانتزی
Chris Renaud, Kyle Balda : کارگردان

Ken Daurio : نویسنده
تاریخ اکران : فوریه 2012

زمان فیلم : 86 دقیقه
زبان : انگلیسی

PG : درجه سنی

من Lorax هستم. بجای درختان صحبت ميکنم. درختانی که خود زبان ندارند

          جای تعجب نیست که موجز گویی کتابهای Dr. Seuss باعث 
شود که داستانهای معروفش به منبعی مناسب برای اقتباسهای تلویزیونی 
در حد برنامه های نیم ساعته تبدیل گردد. اما اقتباس بلند سینمایی )زنده یا 
انیمیشن( از این مجموعه ها نیاز به اضافه کردن جزئیات بیشتر و اصطلاحاً 
کش دادن داستان دارد! Lorax در حالی که به محتوای داستان و رساندن 
پیام نویسنده کتاب وفادار مانده است، نیاز به این داشته است تا برای جلب 
نظر مخاطبانی که به نسخه های کوتاه عادت کرده اند، داستانهایی فرعی 
بنظر  تر  تا خوشبینانه  تغییر دهد  را طوری  پایان آن  فیلم اضافه کند و  به 
به  نه  البته  است.  کننده شده  اثری سرگرم  در مجموع  نیز  کار  نتیجه  آید. 
 How the Grinch Stole یا Horton Hears a Who اندازه
Christmas، اما مسلماً از The Cat in the Hat بهتر است. موفقیتی 
باعث میشود از الان برای اقتباسهای دیگر سینمایی از این کتاب محبوب 

لحظه شماری کنم.
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Lorax ، هم ساختار روایی داستان اصلی که بر پایه بازگشت به گذشته 
)flashback( است را حفظ نموده است و هم به محتوای داستان یعنی 
مجادلات  که  آن  داری  سرمایه  ضد  دیدگاه  و  زیست  محیط  از  حمایت 

فراوانی را موجب شده وفادار مانده است. 
سکانس اول فیلم شهری بنام Thneedville را نشان میدهد که در آن 
پسری دوازده ساله بنام تدِ )Zac Efron( سعی دارد تا دل دختری بنام 
آورد  بدست  را  شده  عاشقش  است  مدتی  که   )Taylor Swift( ادُری 
بجز  اوست.  آرزوی  بزرگترین  برآوردن  نیز  کار  این  برای  روش  بهترین  و 
است.  بیجان  و  منصوعی  کاملًا   Thneedville چیز  همه  آن،  ساکنین 
مردم  و  است  آلوده  بسیار  هوا  تقلبی.  چمنها  و  هستند  پلاستیکی  گیاهان 
هوای سالم را که درون محفظه هایی مخصوص تزریق شده است خریداری 
 .Truffula درخت  دیدن  مگر  نمیخواهد  زیادی  چیز  هم  ادُری  میکنند. 

درختی که زمانی شهر مملو از آن بود و حالا دیگر منقرض شده است.
پیدا  احتمالًا  و  است  آمده  درختان  سر  بلایی  چه  بفهمد  اینکه  برای  تد 
کردن یکی از آنها، باید از محیط امن شهر بیرون برود و در مناطق اطراف 
 Once-ler که چندان جای قابل اطمینانی نیست، به دنبال فردی بنام 
بگردد. در راه موجودی عجیب به او میگوید که چگونه طمع و زیاده خواهی 
Lorax که  و چرا  Truffula شد  رفتن جنگل  بین  از  فرد موجب  این 
وظیفه اش صبحت کردن بجای درختان بود تصمیم به ترک منطقه گرفت. 
 Mr. O’Hare خبر رفتن تد به مناطق خارج شهر باعث نگرانی تاجری بنام
میشود که کسب کارش فروختن هوا به مردم است. تجارتی که وابسته به 
محیطی بدون درخت است. برای همین به تد هشدار میدهد که از این کار 

صرف نظر کند. اما تد این هشدار ها را نادیده میگیرد.
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انتظار دارد در ازای پول بیشتری که میدهد، چیزی متفاوتی ببیند، سعی شده 
نماهایی از پرتاب چیزهای مختلف از سمت شخصیتها به سوی تماشاگر در 
این نسخه گنجانده شود. اما از نظر من این نسخه با نسخه دو بعدی کار 
تفاوت چندانی ندارد و تماشاگر کودک و بزرگسال از آن لذت خواهد برد. 
در نسخه IMAX آن هم که دیگر از لحاظ استفاده از تکنولوژی و جلوه 
های ویژه شورش را در آوردند! درست است که فضای کار پر از رنگهای 
را  فیلم  اینها  از  کدام  هیچ  اما  است  کامپیوتری  جالب  طراحیهای  و  زیبا 

مناسب نمایش در پرده عریض IMAX نمیکند.

Lorax را شاید بتوان پایانی بر رکود تولید انیمیشنهای سینمایی در ماه های اخیر دانست. نام 
Dr. Seuss به خودی خود نشانی شناخته شده است و مخاطب از لحاظ کیفیت به آن اطمینان 
دارد. در نتیجه در گیشه باید فروش خوبی داشته باشد. از آنجایی هم که تماشاگر نسخه سه بعدی
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Lorax ترکیبی است از داستانهای قدیمی و تا حدی از مد 
 – دیالوگها  از  برخی  مدرن.  فناوری  و   Dr.Seuss افتاده 
حتی آنهایی که از داستان اصلی گرفته نشده اند- ریتمیك 
و آهنگین هستند. درختان Truffula، با ظاهر رنگارنگ و 
ابریشمی و خود شخصیت نارنجی Lorax با سبیل کلفتش 
تداعی کننده همان شخصیتهای کتاب هستند که انیماتورها 
با استفاده از گرافیك کامپیوتری جانی تازه به آنها داده اند. 
 Dr. شاید بد نباشد که بدانید مدیر تولید اثر همسر مرحوم
فیلم(  دختر  شخصیت  )همنام   Audrey یعنی   Suess
است و به همین علت است که فیلم اینقدر به متن و محتوا 

وفادار مانده است.
کتاب اصلی اثریست در حمایت از محیط زیست و این هدف 
به خوبی به فیلم انتقال داده شده است. نابودی برنامه ریزی 
شده و سیستماتیك طبیعت و استفاده بی رویه منابع طبیعی 
که بی شك تاثیراتی مخربی در کیفیت زندگی خواهد داشت، 
استادانه در فیلم نشان داده است. از سویی دیگر فیلم به شدت 
 Mr. مخالف تاجر و سرمایه دار است و در واقع شخصیت 
O’Hare را نیز به عنوان نماد همین سرمایه دار به داستان 

اضافه کرده است. 

با عنوان فروش  بارها  و  است  پاک کمی غیر منطقی  و فروش هوای  ایده خرید  این وجود  با 
چیزهای دیگر مانند آب، از گذشته در مورد بحث بوده است. اما یکی از دیالوگها واقعاً جالب است: 

“هر چیزی را که داخل بطری پلاستیکی بگذاری، مردم میخرند!”
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یکی از نقاط قوت فیلم از نظر من این است که اگر صداپیشگان کار را از قبل نشناسید، نمیتوانید حدس بزنید که چه کسی جای کدام شخصیت صحبت میکند. در واقع نه 
اثری از تکیه کلامها و لحن صحبت کردن خاص Danny DeVito است و نه ترانه خوانی Taylor Swift )در غالب شخصیت ادُری که در داستان اصلی وجود ندارد( 

که این باعث میشود تا تماشاگر بجای توجه به بازیگران و خواننده های مورد علاقه شان، حواسشان معطوف به شخصیتهای داستان شود.
ضعف های فیلم برمیگردد به سکانسهایی که از کتاب اصلی اقتباس نشده است و بعداً به داستان اضافه شده اند. نمونه بارز آن شخصیت Mr. O’Hare است که نه آنقدر 
سرگرم کننده است و نه آنقدر توجیه داستانی دارد تا زمانی مناسب از فیلم را به خود اختصاص دهد. در کل، اگر طرفدار کتابهای Dr.Seuss هستید، از فیلم و داستانهای 

اضافه شده به اثر اصلی لذت خواهید بود.



آثار طلایی
فتوگراف برآن است که در هر شماره خود بهترین آثار هنرمندان از قبیل پوستر ، عکس ، نقاشی ، کاریکاتور 

و تصویر سازی را انتخاب  و معرفی کند . 
در ماه های گذشته آثار بسیار و قابل قبولی برای ما ارسال شد که در این شماره و وب سایت مجله از آنها 
رونمایی میکنیم . برای اینکه بتوانیم پاسخ گوی محبت همکاری شما هنرمندان با ما باشیم کلیه آثار شما 

عزیزان را در وب سایت مجله قرار داده ایم. 
دوستان گرامی که از میخواهند آثار خود را برای ما ارسال کنند میتوانند آثار خود را همراه با مشخصات کامل  

به آدرس زیر ارسال کنند . 

BestGfx.Mag@gmail.com



نگين صادقینگين صادقی Negin SadeghiNegin Sadeghi
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حامد قلی زادهحامد قلی زاده Hamed GholizadehHamed Gholizadeh
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رضا پور حسينیمهدی محمدیان  Mehdi MohammadianReza Poor Hoseini
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Sogand Ghale noeiسوگند قعله نوییSogand Ghale noeiسوگند قعله نویی
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Mehdi Mohamadianمهدی محمدیانMehdi Mohamadianمهدی محمدیان
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Ali Barghbaniعلی برقبانیAli Barghbaniعلی برقبانی
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Majed Motayeri  
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Sogand Ghale noeiسوگند قعله نویی



Ali Barghbaniعلی برقبانیReza Por Hoseiniرضا پور حسينی
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Sogand Ghale noeiسوگند قعله نوییFarshadفرشاد
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Helia ataaeiهليا عطائیHelia ataaeiهليا عطائی
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Mohamad javad Vosoghiمحمد جواد وثوقیMohamad javad Vosoghiمحمد جواد وثوقی
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تصاویری که از چشم

دور می ماند .

نشنال جئوگرافیك برای درک بهتر مقالات و گزارش ها درباره مناظر گوشه کنار دنیا، تصمیم گرفت 
عکس هایی با استانداردهای مخصوص خود داشته باشد. ممکن است تصاویری که قدرت نهفته در 
خود دارند از چشم نشنال جئوگرافیك دور بماند ، اما جای نگرانی نیست  چون که ما آنها را برای 

شما به نمایش در می آوریم. 
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Baby Elephant and Keepers

High Tide, Indonesia
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Oil Tanker, Persian Gulf

Water Resort, Dubai
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Manatee, Florida

White Pocket, Arizona
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baby sheep jumping

و اما تصاویر که از چشم نشنال جئوگرافیک دور ماندن.
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A mad cape gannet
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Sea lion close up
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This is how i ride
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Chris sharma breathtaking rock climbing



پرتره منجمد در جاده برفی
در این آموزش قرار است با استفاده از تکنیك دستکاری عکس در فتوشاپ ، 

یك تصویر پرتره در سرما را آموزش دهیم

 Adobe Photoshop CS5 نام برنامه: نرم افزار
سطح آموزش : متوسط

برآورد زمان اتمام: 1:30 ساعت
تعداد گام ها  : 17 تا

تعداد تصاویر آموزشی : 43 تصویر
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ابتدا یك سند با اندازه 11 در 17 اینچ با رزلیشن 300 دی پی ای باز کنید و تصویر جاده برفی را به درون سند جدیدتان وارد کنید همانند 
تصویر شماره 1

پس زمینه در حال حاضر به نظر می رسد بیش از حد روشن است و ما نیاز به تغییر آن داریم که به ایجاد روحیه شب تیره و تاریك 
نزدیك شود. برای این کار به منوی Image > Adjustments > Levels  یا میتوان از کلید میانبر Ctrl + L  استفاده کنید و 

مقادیر زیر را برایش تنظیم کنید )تصویر شماره 2(

با استفاده از ابزار روشنایی / کنتراست تنظیم مقدار روشنایی تا 75 و کنتراست تا 90 برسانید )تصویر شماره 3(

از آنجا که برخی از تغییرات به نور پس زمینه، رنگ کمی بیش 
از حد اشباع شده است. برای حل این مشکل به منوی 

 Image > Adjustments > Hue/Saturation
رفته و میزان saturation را به 45- تغییر می دهیم.

)تصویر شماره 4(

تصویر 2

گام 1

گام2

تصویر 1

تصویر 3 48تصویر 4
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در حال حاضر ما قصد داریم تیرگی پس زمینه را دستکاری کرده و تا جلوه ای بهتر بدست بیاوریم بنابراین 
Filter > Blur > Gaussian Blur را باز کرده و مقادیر را روی 8 پیکسل تغییر میدهیم )تصویر شماره 5(

شما باید همچنین پس زمینه ای داشته باشید )تصویر شماره 6(

در این مرحله، ما قصد داریم به مجموعه لایه های تنظیم شده ، احساس افسرده بدهیم ، ابتدا همه آنها را در یك گروه قرار داده و نام آن را Background میگذاریم .
بعد به منوی Layer رفته بروی New Adjustment Layer بروید و Gradient Map را انتخاب کنید.

همین طور که میبینید یك لایه جدید با پالت رنگ به لایه های شما اضافه میشود )تصویر شماره 7(
روی پالت رنگ کلیك کرده و رنگ ها را مانند تصویر فوق تغییر دهید . )تصویر شماره 8(

رنگ قسمت چپ را بروی کد )000000#( و سمت راست را بروی کد رنگ )032871#( تغییر دهید.

گام3

گام4

تصویر 5

تصویر 7 تصویر 8

تصویر 6
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روی لایه جدیدمان کلیك کرده و از blending mode گزینه Color  را انتخاب کنید ، و میزان روشنایی آن را روی 73درصد قرار 
دهید )تصویر شماره 9(

  Layer > New FIll Layer > Solid Color . را از طریق آدرس رو به رو باز کنید Solid Color اکنون
و رنگ مورد نظر با کد 031E40# را انتخاب کنید و مانند حرکت قبل blending mode را روی Color و میزان روشنایی را این بار 

روی 37 درصد قرار میدهیم. )تصاویر 10 و 11(

از  را   Brightness/Contrast جدید  لایه  یك 
  Layer > New Adjustment Layer منوی 

انتخاب میکنیم و مطابق تصویر تنظیم میکنیم .
)تصویر شماره 12(

 Color Balance مطابق گام 6، ولی اینار یك لایه جدید
  Layer > New Adjustment Layer منوی  از  را 

انتخاب میکنیم و مطابق تصویر تنظیم میکنیم .
)تصویر شماره 13(

گام5

گام6

گام7

تصویر 9

تصویر 10تصویر11

50تصویر13تصویر 12
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در آخر تنظیمات پس زمینه باید تصویری مشابه تصویر شماره 14 داشته باشیم.

در این گام ، تصویر مدل مورد نظر را باز کرده و با ابزار PEN یك 
مسیر در امتداد لبه مدل میکشیم و میخواهیم تصویر مدل را از پس 

زمینه جداکنیم )تصویر شماره 15(
بعد از انتخاب عکس با Pen روی عکس کلیك راست کنید و گزینه  
)تصویر  کنید.  جدا  را  عکس  و  انتخاب  را   Make Selection

شماره16(

عکس برش خورده مدل به روی سند اصلی برده و در 
گروه لایه Backgroud که درست کرده ایم برده و 
در زیر لایه های   تنظیمات رنگ ببرید و سایز عکس را 

کوچك کنید.
 )تصویر شماره 17(

به منظور بهبودی در کیفیت تصویر به منوی زیر
 Filter > Sharpen > Sharpen راانتخاب کنید.

گام8

گام9

تصویر14

تصویر15

51تصویر17تصویر16
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میکنیم  انتخاب  را   Burn tool ابزار    O کلید  دادن  فشار  با 
و سایز قلم را روی 30px و Hardness )میزان نرمی قلم( 
را روی %0 قرار میدهیم. و مانند تصاویر روی پوست صورت و 

دست اعمال کنید. 
)تصاویر 18 و 19(

نکته : به هنگام انتخاب Burn tool روی نوار بالای تصویر 
میتوانید  انجا  از  که  میشود  داده  نمایش  ابزار  به  مربوط  منویی 

سطح کار و تنظیمات ابزار را تغییر دهید. 

این با ابزار Burn tool را باز میکنیم و در منوی مربوط به تنظیمات ابزار Highlights را انتخاب میکنیم و میزان 
exposure را روی %9 قرار میدهیم و مانند تصویر روی خط های کشیده شده اجرا میکنیم. )تصویر شماره 21(

در این تصویر شما میتوانید قبل و بعد اجرای این ابزار را ببینید
)تصویر شماره 22(

همچنین میشود داخل مو و چشم ها را تیره کرد. )تصویر شماره 20(

گام10

گام11

تصویر18

تصویر22تصویر21تصویر20

تصویر19
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در این گام چشم ها را انتخاب کرده و با فشار دادن کلید های  Ctrl + U تنظیمات عوض کردن رنگ چشم را انجام میدهیم . مقادیر 
را مانند تصویر تنظیم کنید. )تصویر شماره 23(

تصویر مدل را در یك لایه جدید ایجاد کنید برای 
همزمان  و  کرده  کلیك  مدل  لایه  بروی  کار  این 
کلید Alt  را نگه دارید و بکشید دوباره یك لایه 
جدید ایجاد کنید و بروی لایه پایینی ماسك کنید . 
برای ماسك کردن لایه بروی آن کلید راست کرده 
و گزینه Create Clipping Mask را بزنید. 

)تصویر شماره 25(

لایه فوق را بروی حالت Overlay با Opacity 15% قرار میدهیم  و بعد نقاطی که در 
تصویر مشخص شده است را با براش 500px و با hardness 0% به نرمی مسواک زدن 

از سمت راست شروع به براش زدن میکنیم. )تصویر شماره 26(

 Brightness می رویم و میزان  Brightness/Contrast در مرحله بعد به همان صورت که چشم ها انتخاب شده اند به منوی
را روی 10+ و Contrast را روی 35+ قرار میدهیم . )تصویر شماره 24(

گام12

گام13

تصویر23 تصویر24

53تصویر26تصویر25
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ماسك دیگری بروی موها قرار میدهیم تا سایه و تیرگی خاصی به موی مدل بدهد )تصویر شماره 27(

 Brightness and Contrast جدید  لایه  یك 
ایجاد و بالای لایه های فوق قرار میدهیم و مقادیر را 

مانند تصویر تنظیم میکنیم )تصویر شماره 28(

لایه های شما باید تا الان به این شکل باشد )تصویر شماره 29(
تصویری که تا الان باید طراحی شده باشد )تصویر شماره 30(

گام14

تصویر27 تصویر28

54تصویر30
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اکنون برای بهتر جلوه دادن تصویر باید فضا را برفی کرد ، ساختن برف رو حتما شما که در سطح متوسط 
کار میکنید بلد هستید و می توانید به سلیقه خودتان برف طراحی کنید . اکنون ما می بایست برف هایی که 
خودمان طراحی کرده ایم را به شکل در حال باریدن درآوریم . برای این کار پس از انتخاب لایه ایجاد شده 
برف به منوی Filter رفته و Motion Blur را از منوی Blur انتخاب میکنیم و با زاویه 50 درجه و 

فاصله 45 پیکسل تنظیم می کنیم )تصویر شماره 31(

سپس لایه فوق را در حالت Lighten قرار دهید و برف های دانه درشت را کمی تار کنید 
)تصویر شماره 32(

حال میخواهیم یخ زدگی را در دست های مدل نشان دهیم بافتی مانند شکل فوق انتخاب کرده و آن را در 
حالت Overlay قرار دهید . )تصویر شماره 33( 

با استفاده از ابزار پاک کن مانند تصویر نقاط خارج از دست را پاک کنید )تصویر شماره 34(

گام15

تصویر31

تصویر32

تصویر33 55تصویر34
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برای بهتر جلوه دادن تصویر از تصاویر یخ و کریستال برای یخزدگی دست ها آرنج ها ، سر شانه ها استفاده کنید ، اکنون ما از تصاویری به شکل قندیل یخ برای یخ زدگی دست ها و آرنج استفاده میکنیم
)تصاویر  شماره  35 ، 36 ، 37  و 38(

دقت کنید که با ابزار برش قسمت های بالای یخ را پاک میکنیم تا شکل بهتری به مدل بدهد.

همچنین برای سر شانه ها هم از یخ های بلور شکل یا اصطلاحاً کریستالی استفاده میکنیم )تصویر شماره 39(

از بافتی که برای یخ زدگی دست ها استفده کرده اینار برای یخ زدگی کت استفاده میکنیم )تصویر شماره 40(

گام16

تصویر35 تصویر36

تصویر39 تصویر40

تصویر37 تصویر38
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در آخر گام میخواهیم از نور هایی برای زیبایی تصویر استفاده کنیم . اول با یك قلم نرم سه دایره به کد های رنگی )  0b2089 , #12dec4# و سفید( میکشیم )تصویر شماره 41(

بعد از منوی Filter>Blur>Motion blur را انتخاب کرده و مانند
 تصویر مقادیر را تنظیم کنید )تصویر شماره 42(

در آخر ما به این تصویر خواهیم رسید .

موفق باشید ...

اکنون تصویر مانند شکل زیر پدید می آید شما باید با کپی کرده و چرخش 
90 درجه ای شکلی بصورت + درست کنید )تصویر شماره 43(

گام17

تصویر41
تصویر42 تصویر43
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www.facebook.com/gfx.mag
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درباره 
هنرمند

اسم من کایل است و یك هنرمند بریتانیایی که متخصص در نقاشی و تصویرسازی هستم .
 در حال حاضر من در رشته تصویر سازی با انیمیشن و به عنوان هنرمند مستقل بصری در بریتانیا شناخته شده ام . هنرمندی که علاوه بر 
کار هنری  به ورزش بخصوص فوتبال، دویدن و دوچرخه سواری علاقه دارم ، در زمان فراغات بهترین و لذت بخش ترین کار من تماشای 

فیلم و آهنگ با دوستان و عکاسی است.

آثار کایل لامبرت .................................................
.....

.....
...

کار من ترکیبی از اشتیاق من برای هنر، فن آوری و داستان گفتن است. من به عنوان یك نقاش سنتی آموزش دیده با در نظر گرفتن نقاط 
قوت اصلی من ،  به دستکاری رنگ، نور و فرم را برای ایجاد تصاویر با قابل توجه خط داستانی، طراحی شخصیت و آثار هنری مفهومی 

مشغول هستم.
 من توجه خوبی به جزئیات و اخلاق کاری قویی دارم ، و مدام برای یادگیری و رشد تلاش میکنم.

کایل لامبرت

کارمن

Kyle Lambert  

Name :  Kyle Lambert
Position: Freelance Visual  
Artist
Location: United Kingdom
Degree : (BA Hons)
 Illustration with Animation
Certified :   Final Cut 
Pro / Motion

Clients

In the past few years I have 
been lucky enough to work 
with clients such as.. Adobe, 
Apple, BBC GQ, Macworld, 
Pixelmator and Wacom.
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درباره 
هنرمند

آثار کایل لامبرت .................................................
.....

.....
...

آثار هنری من در تعدادی از روزنامه ها، وب سایت فن آوری 
و برنامه های تلویزیونی در سراسر جهان برجسته شده است. 
بازدید  میلیون   2 از  بیش  یوتیوب  در  آموزش من  فیلمهای 

داشته است .
من هنرمند برجسته در نمایشگاه Macworld 2011 در 
سان فرانسیسکو بوده ام ، و دعوت به سخنرانی و  ارائه بحث 

در مورد آثار هنری دیجیتال و تظاهرات زنده بودام.
از  از اعلامیه های محصول  نیز در تعدادی  آثار هنری من 
جمله ادوبی اعلام برنامه لمسی، اپل iCloud در سال اپل 

با حضور استیو جابز به نمایش در آمده است

دستاوردها
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درباره 
هنرمند

همچنین مجله فتوگراف قصد دارد تا آموزش های فوق را
ترجمه و برای علاقمندان و مخاطبان گرامی در شماره های 

بعدی منتشر کند .

در وب سایت شخصی Kyle Lambert و یوتیوب میتوانید آموزش های او را به رایگان ببیند.
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کار
رد 

شب
ر پي

ا د
ره

کا
راه

 از 
ی

رخ
ش ب

موز
آ

آموزش برخی از راهکارها در پيشبرد کار

ترجمه : رامين سلمانی
Ramin@gfx-mag.com

بعضی از رموزی که ما در دفتر کارمان استفاده میکنیم 
را بیاموزید!

برای هر هنرمندی مهم است که بداند در کجا میتواند 
تصاویر موردنظر فونت ها و یا حتی برنامه های اموزشی 

خودرا بصورت جامع بیابد.
گام بعدی دراین مورد چگونگی استفاده از این منابع در 

جهت منافع شماست.
ما به عنوان طراح بر این مهم واقفیم که داشتن لیستی 
دارای  میزان  چه  به  دسترسی  قابل  و  معتبر  منابع  از 

اهمیت است. 
شما هرگزنمیدانید چه زمانی به عکس یا فونتی مناسب 
از  که  تبلیغاتی  کار  یك  یا  )تارنما(  سایت  وب  برای 

سوی یك مشتری سفارش داده میشود نیاز دارید.
برای همین ما در این شماره قصد داریم تعدادی ازمنابع 

کارامد را به شما معرفی کنیم.
براساس:           شده  بندی  طبقه  لیست   4 ما  دراینجا 
اصول عکاسی,فونت,رنگها واموزشهای فتوشاپ آماده 

کرده ایم.
گروه طراحان خبره ما در این مجله از همین منبع به 

طور گسترده استفاده میکنند.



64

TRAINING
آمــوزش

مجله فتوگراف / شماره یک / سال اول / تیر ماه 1391 / رایگان

من وهمکارانم درگروه مجله فتوگراف در اموزش و رشد 
منابع  تا  اموزشی مصمم هستیم  برنامه های  و همچنین 

کارامد جدیدی را برای خوانندگان گرامی فراهم کنیم.
با  را  خود  کاری  اسرار  برخی  توانستیم  تا  خوشحالیم 
ادامه  در  امیداریم  و  بگذاریم  میان  در  مجله  دوستداران 

راه به شما کمك کند.

وب سایت های عکاسی
Free Websites

http://www.sxc.hu http://www.shutterstock.com

http://www.istockphoto.com

http://www.pixmac.com

http://www.dreamstime.com

http://www.ingimage.com

http://www.photl.comen
http://imagebase.davidniblack.com

http://www.stockvault.net

http://www.photovaco.com

Paid Websites
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وب سایت های تایپوگرافی وفونت

Free Websites

http://www.dafont.com

http://www.type-together.

http://www.dstype.com

http://www.tipo.net.ar

http://www.pizzadude.dk

http://www.fontfabric.com

http://www.fawnt.com
http://www.urbanfonts.com

http://www.fontspace.com

http://www.creamundo.com/en

Paid Websites
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وب سایت های پالت رنگ
Free Websites

http://kuler.adobe.com

http://www.colourlovers.com
http://www.colorschemedesigner.com

http://www.colorexplorer.com

http://www.colorotate.org
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وب سایت های آموزشهای فتوشاپ

Free Websites

http://psd.tutsplus.com

http://www.abduzeedo.com/tags/photoshop
http://www.photoshopstar.com

http://www.photoshoplady.com

http://www.bestphotoshoptutorials.net
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عكاسی                   نمادی از گذشته ی زنده ، یادمان قدیم  و خاطره ای از امروز آدمی برای 
فرداهاست . مجله فتوگراف قصد دارد در بخش عکاسی نکات مفید و کاربردی عکاسی را  
در قالب آموزش به دوستان علاقمند ارائه دهد. اگر شما عکاسی می کنید و یا یك منتقد 
عکاسی هستید اینجا جایی است که مطالب ، نقطه نظرات و آثارتان را به نمایش درآورید.

Aks@Gfx-Mag.com

عکس
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عكاسی

سرعت شاتر در عکس با حرکت نسبت پیچیده ای دارد ، عکاس میتواند از این حالت برای ساکن بودن و نشان دادن حرکت در عکس استفاده کند 
. با این تکنیك و تنظیم مناسب میتوان تصاویر خلاقانه ای ثبت کرد. سرعت شاتر کم در شرایط سکون را مردم بیشتر مینوانند در سرعت کم در 
شاتر پایینی و در حدود 1/60 ثانیه دوربین را به اندازه لازم ثابت و بدون لرزش نگه دارند که با استفاده از یه تکیه گاه و یا با حالت مناسب بصورتی 

که بازوهارو به پهلو بچسبانید را میتوان با سرعت شاتر پایین در حد 1/15 برسانید و عکسهای دقیقی بگیرید.
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عكاسی
نخستین دستگاه های عکاسی به روش داگرئوتیپ، 
به درخواست محمد شاه قاجار از کشورهای روسیه 
دستگاه  شد.  وارد  ایران  دربار  به  انگلستان  و 
بود،  امپراتور  هدیه  که  روسیه  عکسبرداری  های 
جوان  دیپلمات  پاولوف(  و)نیکلای  زودتررسید 
این منظور تعلیم عکاسی دیده بود،  روس که به 
اواسط  در  و  آورد  تهران  به  را  ها  دستگاه  این 
هجری   1221 آذر  پایان  مطابق  دسامبر1842، 
انجام  را  ایران  در  شمسی، نخستین عکسبرداری 

داد.
شاه  محمد  ایران،  به  عکاسی  دوربین  ورود  با 
آشنا  نوظهور  پدیده  این  با  تا  داشت  تمایل  قاجار 
شود. به همین خاطر تصویر شاه، بعضی ازاعضای 
و  شاه  وزیر  آغاسی؛  میرزا  حاج  درباری،  خانواده 
برخی درباریان در یکی از کاخ های تهران روی 
صفحه نقره یا داگرئوتیپ، ثبت شد. در سال 1844 
میلادی، با ورود جوانی به نام ژول ریشار که برای 
کار به ایران آمده بود و مهارتی هم در عکسبرداری 
قاجار،  شاه  محمد  از  داشت،  داگرئوتیپ  شیوه  به 
خانواده پادشاهی و درباریان بارها و بارها، عکس 
در  سپس  ریشار،  ژول  کرد.  تهیه  فراوانی  های 

دارالفنون به تدریس زبان فرانسه پرداخت.

حمایت  با  شد.  گنجانده  دارالفنون  درسی  های  برنامه  در  1860میلادی  سال  از  پس  عکاسی 
ناصرالدین شاه از عکاسی، زمینه های گوناگون این فن و هنر در سالهای آغازین، باعث رشد و 
شکوفایی آن شد. پس از آقا رضا عکاسباشی هم باید ازشاگردانش و کسانی که به عنوان دستیار، 
نزد وی در عکاسخانه همایونی کار می کردند، اشاره کنیم. از آن به بعد عکاسانی که پس از او 
به عنوان عکاس دربار یا عکاس مدرسه دارالفنون برگزیده شدند، اشخاصی هستند که از شهر 
تهران و موضوعاتش، عکاسی کردند. این عکاسان عبارتند از: آقا یوسف عکاس، میرزا حسنعلی 
عکاس، میرزا ابراهیم عکاسباشی، سوریوگین، ژوزف پاپازیان و... بنابراین از عکس های موجود 

این دوران، می توان به بخشی از راه و رسم زندگی آن زمان پی برد.

تاريخچه عكاسی در ايران

مهين معاوی
icanphoto@yahoo.com

لباس فروشی دوره قاجار

پوشش زنان دوره قاجار
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عكاسی ناصرالدین  زمان  در  که  جالبی  کارهای  دیگر  از 
گزارش  گرفت  عکاسی صورت  با  رابطه  در  شاه 
های تصویری از زندانیان، محبوسین و محکومین 
جزایی و سیاسی بود. عکس چهره میرزا رضای 
نوع  این  است.  ها  نمونه عکس  این  از  شاکری، 
از  سازی  پرونده  همچون  کارکردی  ها  عکس 
برای عبرت  یا  و  افراد  و سیاسی  سوابق قضایی 

آموزی دیگران داشته است.
قمری،  هجری   1285 سال  در  چندی،  از  پس 
اولین عکاسخانه عمومی هم به فرمان ناصرالدین 
شاه در تهران تاسیس شد. روزنامه »دولت علیه 
ایران« هم در آن روزگار با چاپ اطلاعیه ای، از 
آن خبر داد: چون اغلب مردم زیاده از حد مایل 
و راغب هستند که عکس خود را بیاندازند و در 
عکاسخانه مبارکه دولتی همه کس نمی توانست 
برود و عکس خود را بیاندازد،عکاسباشی، عباسعلی 
او بوده  بیگ آدم خود را که مدت ها زیر دست 
و تربیت شده و در عکاسی کمال مهارت را پیدا 
کرده بود، قرار گذاشت در خیابان جباخانه مبارکه 
) باب همایون کنونی( حجره ای ترتیب واسباب 
انداختن  را میل  تا هر کس  نماید  آماده  عکاسی 
و  بیاندازد  رفته عکس  درآنجا  باشد،  عکس خود 
قیمت آن هم موقوف به بزرگ و کوچکی عکس 
است: عکس بزرگ یکی چهار هزار »دینار« است 
توجه  قابل  نکات  از  دیگر  یکی  عدد.  دوازده  تا 
درعکاسی دوران قاجار، عکاسی توسط زنان بود.

نخستین عکاسان زن ایرانی را باید در میان زنان 
شیفته  خود  که  قاجار  شاه  ناصرالدین  حرمسرای 
آلبوم  از  این فن بود، جست وجو کرد. در برخی 
گلستان  کاخ  خانه  آلبوم  در  که  ناصری  های 
موجود است، آثاری از این زنان عکاس که به طور 
تفننی به عکاسی می پرداختند، دیده می شود. اما 
نخستین زن ایرانی که به صراحت بر عکاسی او 
»اشرف  به  ملقب  خانم  ملك  عزت  شده،  اشاره 
السلطنه« همسر محمد حسن خان اعتمادالسلطنه 
وزیر انطباعات دوران ناصری است که عکاسی را 
فرا  خود  عموی  پسر  محمدمیرزا«  »شاهزاده  از 

گرفته است.
نیمه  پیشگام  عکاسان  از  یکی  آلمانی،  مهندس 
دوم قرن 19 میلادی است که در زمان ناصرالدین 
از عمر  به 20 سال  نزدیك  و  آمد  ایران  به  شاه 
منحصربه  مجموعه  گذراند.  اصفهان  در  را  خود 
فرد عکس ها ی هولستر، سال ها از نظرها پنهان 
او  نوه  ریکولتا،  خانه  در  اتفاق  یك  اثر  بر  و  بود 
او در طول سال  آلمان به دست آمد.  در مانستر 
دیگر  نقاط  و  اصفهان  از  عکس  حدود3000  ها 
ایران گرفت. عکس هایی از خانه و خانواده خود، 
کبوترخانه  ها،  پل  مساجد،  ها،  باغ  ها،  کوچه  از 
ها،  کجاوه  ها،  گله  کشتزارها،  ها،  امامزاده  ها، 
اصفهان،  رجال  و  حکام  ها،  خانه  ها،  کاروان 
علما، بازرگانان، پیشه وران، زرتشتیان، افغان ها، 

کلیساهای جلفا و کشیشان و تارک دنیاهای 

ارمنی، عروس و دامادهای ارمنی، رجال ارمنی جلفا، مجالس تعزیه و تعزیه گردان 
ها، زورخانه و پهلوان ها، مراسم عروسی و میوه ها و... شاید در نگاه اول، تصاویر 
هولستر فقط یك تعداد عکس معمولی از یك دوره تاریخی و از مردم و اصناف و 

بناهای آن دوره باشد.

تاريخچه عكاسی در ايران

پل خواجو ، اصفهان

اولین آتشنشانی در ایران ، آبادان دربند ، تهران



دیده شوید
با فتوگراف دیده شوید. 

Info@gfx-mag.com   تبلیغات در مجله



انسانم!

ميخواهد
 بی هنرترینو من 

کردن تو
فراموش

هـــنر 

www.Gfx-Mag.com






